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Foreword 

This booklet has been produced as part of the joint activity of the ProSICD project and the 

GIZ Sector Programme for Sustainable Agricultural Supply Chains and Standards (INA). 

Designed by the geomatics experts of the company ACTUM DEV, this booklet offers 

technical and practical solutions for sectors working in the development and management 

of land and ecosystems. Specifically, it was produced taking into account the needs of 

cooperatives, regional councils, commodity-related councils, and technical government 

entities, such as ministries of territory, agriculture, water, forests, planning, etc. As such, 

this manual addresses the following pillars: 

- Good practices for field data collection and storage , 

- Learning and mastering the use of cartographic software for data management and 

processing, 

- Solutions to specific needs encountered in the field, 

- Decision-making tools in the face of sustainability issues (especially deforestation). 

This booklet was made possible thanks to:  

• ProSICD (Sustainable Cocoa Initiative Support Programme), co-financed by the European 

Union and the Federal Ministry for Economic Cooperation and Development (BMZ) 

through the Agrichains project;  

• The GIZ Sector Programme for Sustainable Agricultural Supply Chains and Standards 

(INA,) which is a transnational project that focuses on agricultural commodities such as 

coffee, cocoa, bananas, soybeans, rubber, palm oil and cotton;  

• To the experts:  

✓ For GIZ: 

Dr Henriette Walz - GIZ Component Manager; 

Lorenz Beck, Jonas Spekker, Pascal Ripplinger – Initiative for Sustainable 

Agricultural Supply Chains (INA) 

 

✓ For ACTUM DEV: 

Abraham BIO, Geomatics Expert and CEO of Actum Dev; 

Dieu-Donné DIBI, Geomatics Expert and Technical Director of Actum Dev; 

Elie KOUMAN, PhD in Geography and expert consultant for Actum Dev; 

Korohognon COULIBALY – Geomatics engineer and assistant trainer; 

Jephté BROU, Geomatics engineer and assistant trainer; 
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0.1. Contextualization of training 

An example from Côte d´Ivoire 

Mr. Yapi Gaston is a cocoa producer with 10 hectares of plot. To secure the plot that he 

obtained from his father, he decides to participate in the Land Policy Improvement Program 

initiated by the State (PAMOFOR) in order to obtain a Land Certificate (LC). During validation, 

his file is put on hold because part of his plot would end up in classified forest. He therefore 

seeks help from the water and forestry department which is technically unable to answer him. 

However, it guides him to the forest registry office in Abidjan, which gives him a technical file 

confirming unfortunately that his plot is partly in a classified forest.  

Mr. Yapi also discovers that because of that area of his plot in the classified forest, his 

production could not be sold by his or any other cooperative because of new regulations such 

as the EU Deforestation Regulation (EUDR). This situation is not isolated, as it affects several 

other parcels of members of the cooperative. The cooperative's revenue is threatened to take 

a big hit.  

With all the national and international regulations, buyers demand cooperatives to prove that 

their cocoa does not come from deforested areas or classified forests (through provision of 

polygons) under penalty of not being able to sell their production. 

Under pressure, the CEO of the cooperative calls a consultancy company for an audit of their 

plot, but the cost of this activity is very high given the limited time. This situation could have 

been avoided beforehand with good data collection by field agents equipped with GPS devices. 

This scenario is one case among many that all actors in the agricultural and land sector could 

face (producers, cooperatives, technical agents of water and forestry, agents of municipalities 

and regional councils, commodity boards such as the Ivorian Conseil Café Cacao, etc...). 

 

This manual is made to provide a technical foundation to address this kind of scenario. In 

summary, this manual provides information on: 

 How to collect quality data in the field;  

 How to process field data and produce coherent and useful databases to anticipate the 

aforementioned problems; 

 How to continuously fill in databases and keep them up to date; 
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 How to produce maps easily presenting the data collected and facilitate the decision of 

the hierarchy. 

0.2. Challenges of cooperatives 

This training addresses several challenges that cooperatives may encounter. Through this 

training, cooperatives will be better able to: 

 Monitor and manage the data of members' farms; 

 Identify problematic farms and provide effective solutions for the benefit of the 

cooperative; 

 Make better estimates of the overall production (advance knowledge and control of the 

cooperative's turnover); 

 Better plan and deploy activities during campaigns; 

 Anticipate land issues and help producers; 

 Better access finance; 

 Easier market quality products . 

0.3. Training objective 

The objective of this training is to strengthen the capacities of cooperatives and other actors 

to use GPS and QGIS, as well as how to read maps and use them in the sustainable management 

of agricultural, forestry and environmental activities. Specifically, this training will help to: 

 Explain the basics of geographic information; 

 Work with GPS data in QGIS; 

 Collect geographic data in the field; 

 Use GPS and mobile tools with QGIS; 

 Implement thematic mapping; 

 Modify geographic data and create maps 

0.4. Target 

This training document is published for technical officers in the agricultural, forestry and land 

use planning sectors. It is specifically designed for: 

• Agricultural cooperatives; 

• Agents of ministries; 

• Technical sustainability officers of regional councils 
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0.5. Disclaimer 

This manual was designed in 2023 with the technologies available at the time. The software 

packages used (QGIS installers) are available from this page https://www.qgis.org. The used 

version was QGIS 3.26.3 'Buenos Aires', released on 09.09.2022. The stable long-term release 

version at the time of conception is QGIS 3.28.10 'Firenze'. QGIS is available for Windows, 

macOS, Linux, Android and iOS. 

https://www.qgis.org/
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1.1.  Purpose of the module 

The aim of this module is to provide participants with a basic understanding of the entire 

training program, covering the concepts and fundamentals required to understand the 

following modules. It provides definitions and explains principles. 

1.2.  Definition and principle of cartography 

Cartography is a set of methods and techniques for making a map. The purpose of a map is the 

graphic and geometric representation of the entities and phenomena observed in an area, 

resulting from the analysis of qualitative and/or quantitative data.  

The creation of a map requires several stages: 

1. Research and/or data production; 

2. Data analysis and quality control; 

3. Storage in a secure database if the data is sensitive; 

4. Drawing the map, following certain graphic design rules. 

The main principle of cartography is the representation of data on a reduced medium, 

representing a space that is generally considered to be real. The objective of a map is to 

represent complex phenomena (political, economic, social, etc.) in a concise and effective way. 

1.3.  History of Cartography 

The history of cartography began with the desire to see the world as a whole. This vision took 

shape with the technical advances that made it possible to obtain a more accurate image of 

the earth. 

The birth of scientific cartography is generally attributed to Ptolemy, a Greek astronomer, 

mathematician and geographer from the 2nd century AD, who compiled the knowledge 

available in geography at the time.  
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Modern maps 
With the arrival of aerial 

photography, computers and 
satellite imagery, cartography has 

been revolutionized and is reaching 
into all fields. 

The Era of Clay Disc Cards 
engraved by scribes. 

The era of geographic coordinates 
With the work of Ptolemy and 

Eratosthenes it was possible to calculate 
the first geographical coordinates around 

the year 3 BC. 

Maps in the scientific age  
In the 18th century, cartography 

definitively moved away from its medieval 
roots and became truly scientific. It was 

the century of exact measurements. 

The beginning of thematic maps 
In 1746, Jean-Etienne Guettard drew up 

mineralogical maps (precursor of the 
geological map). These maps were a 

sensation and demonstrated a new spirit 
of research. 

Exploration maps 
Based on the work of Ptolemy, the 

geographic explorer Idrisi (12th 
century) draws up a map that aims 

to discover the world. 

1746 

18th 
cent. 

12th-
16th 

700 
BC 

06-02 
BC 

Today 

Graphic based on Minelle, 1992 
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1.4. Definition of concepts 

1.4.1. Rasters and vectors  

There are 2 main types of geographic data in GIS: "Rasters" and "Vectors": 

• A Raster corresponds to grids composed of cells (like an "image" composed of pixels). 

Each cell contains a value that often represents a geographical phenomenon, for 

example, altitude or land cover. It can be a scanned map, an aerial photograph, a 

satellite image, a digital photo, or a DEM (Digital Elevation Model) 

• Vectors are composed of points, lines or polygons. The most common vector file format 

in GIS is the "shapefile" format and therefore the name "shapefile" is often used as a 

synonym for "vector file". 

 

 

 

 

 

 

 

 

NB: GPS data is therefore "vector" data. 

 

1.4.2. Cartographic forms  

Point: a geodetic feature 

defined by a pair of x,y 

coordinates. 

Line: a shape defined by a 

connected series of points. A 

line can be straight or 

curved. 

 

Polygon: a closed shape 

defined by a series of points. 
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1.4.3. Scale 

Scale refers to the ratio between a real distance, measured on the Earth's surface and that of 

its representation on a map. Since it is a ratio, the scale will be "small" when the denominator 

is large and conversely "large" when the denominator is small (e.g., from 1/1,000,000 to 

1/25,000).  

 

1.5. Key advantages of digital mapping and fields of application  

Unlike conventional mapping, the new digital mapping is characterized by: 

• Its powerful storage capacity and 

variety of print formats; 

• Its ability to modify and represent 

large volumes of geospatial data; 

• Its flexibility to adjust scale and 

disseminate geospatial data; 

• The possibility to modify an old 

map, remake it and personalize it 

• Its ability to do the layouting of the 

map. 

Nowadays cartography is used in several fields such as: 

• Mineral prospecting: to search for 

minerals, collect prospecting data, 

process them and represent them 

in geological maps; 

• Risk prevention and management: 

through the creation of databases 

of critical facilities, such as hospitals, 

ambulances, fire stations, police 

stations, schools etc. Similarly, 

disaster maps can be prepared to 

show areas at risk as well as 

potential disaster impact areas; 

• Water management and geospatial 

representation of measured water 

variables (hydrology); 

• Urban planning (land registry, roads, 

road network management): 

contributes to site selection, land 

balance analysis, land use and 

transport modelling, identification 

of planning action areas and impact 

assessments; 

• Urban transport planning and route 

optimization: provides information 

on the transport infrastructure 

cycle, and enables complex systems 

to be planned, monitored and 

managed more efficiently; 

• Forest development, harvest 

management, silviculture: mapping 

of flammables and weather 

conditions and assessment of fire 

danger, which can have a negative 

influence on vegetation cover, 

animals, plants, soil, water flow, air 
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quality, microclimate and general 

climate; 

• Animal population movement; 

• Telecommunication: Assistance in 

the choice of antenna mounting 

locations (e.g., in remote areas); 

• Tourism: Management of tourist 

infrastructure and routes; 

• Customer acquisition and 

management . 

1.6. What to remember 

Cartography is a way of analysing, defining and interpreting geographic space and the elements 

within it. It provides information about element or phenomena in given parts of the world. 
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2.1. Purpose of the module 

Have you ever encountered the situation that when you take GPS points of two neighbouring 

plots, the polygon boundaries overlap? 

Have you ever found that you've taken points in the field but, once back at the office, they've 

been recorded or observed miles away from your initial position? 

If so, this module will enable you to understand the causes in order to anticipate and avoid 

these errors on your next field mission. It will give you the essential understanding how GPS 

works, so that you can optimize data collection and obtain good-quality data. An important 

word will occur several times in this module: "accuracy”. Our approach is to discover the history 

of GPS and to bring out the essential information for using your GPS device with the various 

existing systems. 

2.2. History of GPS 

The Global Positioning System (GPS) is a satellite-based positioning system owned by the US 

government. In the context of the arms race and emerging new technologies, it was set up by 

the US Department of Defense for military purposes from 1973 onwards. 

Initially, the aim was to enable soldiers to locate and orientate themselves accurately in order 

to gain a strategic advantage over the enemy. 

The first satellite was launched in 1978. In 1983, following the deaths of 269 passengers in the 

Korean Air Lines flight 007 incident, President Ronald Reagan proposed that GPS technology 

should be made available to civilians free of charge once it was operational. A second series of 

satellites was launched in 1989 to build up a sufficient fleet. 

In 1995, the deployment of the 24 operational satellites (plus 4 in reserve) was completed 

and the system became operational. The number of satellites available meant that GPS could 

be used around the world at all times, with an accuracy limited to around 100 metres for 

civilian use.  

In 2000, President Bill Clinton confirmed the value of the technology for civilian purposes and 

authorised unrestricted broadcasting of GPS signals with an accuracy of approximately ten 

metres. It was made available to the general public in mid-2000. 

The United States continues to develop its system by replacing and adding satellites and by 

making available additional GPS signals that are more accurate and require less power from 
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the receiving equipment. An interoperability agreement has also been confirmed between 

the GPS systems and Galileo, the system set up by the European Union, to ensure that the 

two systems use the same frequencies and are compatible with each other. 

Note: GPS is a system, not a device. GPS is an American system. However, other positioning 

systems exist, including the following: 

• Galileo from Europe (launched in 1999 by the 

European Union, operational; 

• GLONASS from Russia. Launched from 1980, 

operational; 

• Beidou from China. Launched in 2000, 

operational. 

Satellite systems (GPS & GLONASS) can be supplemented 

by so-called overlay systems, which deliver real-time corrections to increase accuracy, as well 

as information to guarantee the integrity of these corrections. 

2.3. Understanding the GPS system and how it works  

Signals transmitted by the satellites can be freely received and used by anyone. Users, whether 

on land, at sea or in the air, can find out their position at any time and in any place on or near 

the Earth’s surface with unprecedented accuracy, as long as they are equipped with a GPS 

receiver and the software needed to process the information received (nowadays this applies 

to most mobile phones). 

2.3.1. GPS operating principle 

GPS positioning works with a method that you might already be familiar with: trilateration. 

For a simplified explanation, imagine that you are moving around anywhere on Earth with a 

GPS receiver in your hand. The circle in red represents your distance to a GPS satellite orbiting 

earth above you. 

GPS 

BEIDOU 

GLONASS 

GALILEO 

www.kelloggreport.com 

http://www.kelloggreport.com/GNSS-GPS-GLONASS-and-Galileo.html
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Step 1: For the moment, with a single satellite, your GPS device 

cannot identify your position. It can only calculate the distance 

between your receiver (you) and the satellite. You may be 

anywhere on the red circle. 

 

 

Step 2: Now your receiver will pick up another signal from a 

second satellite. At this moment, your receiver is doing 

calculations in the background to determine two positions, 

which is where the depicted circles intersect. You may be 

located at either of the two spots. Your exact position is still 

uncertain.  

 

 

Step 3: Your receiver picks up the signal 

from a third satellite. Your distance from all 

three satellites, as depicted by the three 

circles, intersects at a single point. This is 

your position.  

Note: In principle, 3 satellites suffice to 

determine your position (latitude, longitude 

and elevation), however, a 4th satellite is needed to synchronise the receiver’s internal clock 

so that your position is more refined and precise.  

 

2.3.2. Accuracy 

Geographical accuracy is a concept that is closely linked to the positioning that a set of satellites 

can provide and is different from the concept of scale. Accuracy is the absolute difference 

between the values of the coordinates in a geographic dataset and the true values. In simple 
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terms, it is the difference between the position of the entity in the dataset provided by the 

positioning device and the true/actual position. 

For example, if we say that the accuracy is 2 metres, then this literally means that the true 

position can be found at any point in a circle with a radius of two metres from the GPS-

determined position. 

 

 
 

 
 
 

2.4. What to remember?  

GPS is not an electronic device but a positioning system from the USA. However, positioning 

devices operating on GPS and other systems are often simply referred to as ‘GPS’. 

GPS is not the only geolocation system, there are also Galileo from the EU, GLONASS from 

Russia, and Beidou from China. 

GPS requires at least 4 satellites to give an accurate position. 

Accuracy is a key factor in locating with any positioning system. 
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3.1. Purpose of the module 

This module will briefly introduce the concept of Coordinate Reference Systems in cartography 

and geography.  

 

3.2. What is a CRS? 

CRS: A Coordinate Reference System (composed of a projection and a datum) is a reference 

frame in which elements in space can be represented. This system makes it possible to locate 

oneself on the entire globe using a pair of geographic coordinates. 

The subject of map projection is very complex and even professionals who have studied 

geography, geodesy and other GIS-related sciences often have problems with the correct 

definition of map projections and reference coordinate systems. Usually, when you work with 

GIS, you have already projected the data to begin with. In most cases, this data will be projected 

into a certain CRS (most commonly the World Geodetic System 1984 or WGS 84, also known 

by its EPSG code 4326), so you don't need to create a new CRS or even project the data from 

one CRS to another. That said, it's always useful to have an idea of what ‘map projection’ and 

‘CRS’ mean. For further information, please read Coordinate Reference Systems — QGIS 

Documentation. 

 

3.3. The WGS 84 reference system  

WGS 84 (World Geodetic System 1984) is a worldwide geodetic system. It comprises a 

coordinate system, a reference ellipsoid (the IAG GRS 80 resolution ellipsoid) and a geoid 

(EGM96). WGS 84 is used by the GPS satellite positioning system. WGS 84, also known by its 

EPSG code 4326, is usually set as the default CRS in many GPS devices. You should however 

make sure that that is the case before you start mapping. 

  

https://docs.qgis.org/3.34/en/docs/gentle_gis_introduction/coordinate_reference_systems.html
https://docs.qgis.org/3.34/en/docs/gentle_gis_introduction/coordinate_reference_systems.html
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IV- MODULE 4: GETTING STARTED WITH 

GPS  
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4.1. Purpose of the module 

GPS is an important tool to know when you're involved in agriculture, forestry, and land 

management. The aim of this modul is to get to know a GPS receiver in a useful way, from its 

various functions to its handling. 

4.2. Introducing GPS receivers 

4.2.1. GPS functions 

A GPS receiver can be used for a number of purposes, including: 

• Calculating a location (main use); 

• Calculating speed; 

• Calculating the distance to a point or area; 

• Calculating a route. 

It can also be used as a compass and has memory space to save information. 

4.2.2. Types of GPS receivers 

There are several types of GPS receivers, as several manufacturers produce this type of 

electronic device. Some of the most commonly used are the following: 
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4.2.3. Overview of the Garmin receiver 

 

4.2.4. Functions of the buttons 
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4.3. Display 

The GPS receiver has several main pages that can be accessed using the button . 
When you click the "page" button, you can choose to display one of the following pages: 
 

Main Menu Map Compass 

   
This page contains the main menu 
with a number of functions, 
including 
- Device setup 
- Waypoint management 
- Route planning 
- Zone calculation 
- Satellite overview 
- etc… 

The map display page 
contains a cursor which 
indicates your current 
position on the map (when 
you move, the cursor moves, 
too). 

When navigating, the 
compass indicates directions 
to follow and the direction of 
the destination (North, 
South, East, West). 

Trip computer Elevation plot  

 
 

 

This page displays trip 
characteristics (current speed, 
average speed, distance travelled, 
etc...). 

This page graphically displays 
altitude as a function of 
distance travelled. 

 

 

 

  



 

27 

4.4. Main menu functions 

The main menu functions described below are essential for everyday use of the GPS receiver. 

4.4.1. Setup menu 

1. Setting up the satellite positioning system(s) to be used:  
GPS or GPS+GLONASS or GPS+GALILEO 

2. Setting the battery type 
Alkaline/Lithium/Rechargeable NiMH 

3. Position format (type of coordinates)  
Decimal degrees / UTM zone / etc… 
 

Exercise: Set the position format to  

• Decimal degrees: hddd.ddddd° 

• UTM: UTM UPS 
 

4.4.2. Waypoint manager 

1. Waypoints: recorded positions stored in the GPS device’s memory  

2. The waypoint manager is used to modify or delete waypoints  

3. Creating a waypoint: MARK button  

4. Navigate to a waypoint: FIND button > Waypoints > Selection > Go 
 

4.4.3. Track manager 

A track is the automated recording of your route that combines the various  

points along the way recorded (time, location, altitude). 

The Setup / Tracks menu is used to configure track recording: 

1. Track log: enable or disable the recording of tracks 

2. Recording method (distance, time, automatic) 
 

Exercise: Delete the currently tracked route 
 

4.4.4. Satellite 

• The satellite page shows the satellites "seen" by the GPS receiver 

• On start-up, the "satellite search" message is displayed.  

• When a sufficient number of satellites (>4) are detected, the location 
can be calculated -> the Satellite page shows the current position, GPS 
accuracy, satellite location and signal strength 
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4.5. Practical exercises 

Field exercise (groups of 2) 

1. Recording of 10 waypoints + detailed description 

a. Starting point 

b. Various points of interest along a 100m route 

2. View waypoints and tracks on the map 

 

Upon arrival: 

3. View the characteristics of the route 

4. View the altitude profile 

 

 

Waypoint manager exercise: 

1. Display the waypoints recorded in the waypoint list 

2. Modify a waypoint (and add a comment) 

3. Display the recorded waypoints on the map 
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V- MODULE 5: GETTING STARTED WITH 

THE GPS MOBILE APP 
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5.1. Purpose of the module 

Besides professional GPS receivers, other devices such as most mobile phones can use the 

Global Positioning System with dedicated software. In this module, we will show you how to 

use the OSMTracker application for Android phones. With OSMTracker you can record precise 

coordinates, as well as take photos and notes when collecting data in the field. 

5.2. Download the OSMTracker application and discover the interface 

There are several mobile GPS applications for both Android an iOS. For the purposes of this 

course, we will use OSMTracker, because it is easy to access (free), easy to use and highly 

accurate (up to 2m). 

OSMTracker is an Android mobile application that lets you use your smartphone to collect 

geographical information and record your tracks, just like a professional GPS receiver.  

Download and install the OSMTracker application (available from the Google Play store).  

 

 

5.3. Getting started with OSMTracker 

On Android phones, you have to activate location services in your 

settings and make sure you are located outdoors to facilitate a fast 

reception of the GPS satellite signals.  

Once the application has started, the interface shown on the right will 

appear.  
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As soon as GPS signal reception is activated, the application starts to continuously record its 

location in the background. In order to obtain accurate data right from the start, we 

recommend that you configure the GPS settings first. To do this, click on the three dots at 

the top right and then on “settings”. In the “GPS” menu option, we now configure the 

tracking options so that your location is only recorded every 5 seconds (“GPS logging 

interval”) and from a minimum distance of 5 metres (“GPS logging distance”). 

Now, back in the home view, we can click on the marker with the plus sign at the bottom right 

and start our GPS tracking. 

          

If satellite signals are not yet picked up, the data collection interface appears dark grey. As 

soon as enough signals are picked up, the interface becomes lighter, and the signal bars 

indicate that the satellite GPS signals are being received. After a short wait, the signal should 

improve, as shown in the example on the right. 
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A GPS track is now automatically recorded in the background. You can start moving to record a 

track. If you want to mark points of interest (POIs) along the track (such as corners of a polygon), 

two main functions are used: the TEXT NOTE function and the TAKE PHOTO function. 

TEXT NOTE: Used to pick up any type of POI at the 

current location, with a note to support it. 

TAKE PHOTO: Allows geo-

referenced photos to be taken. 

Mark the point by clicking 

on the text note. 

Make a note of the name 

of the point in the 

dialogue box that opens, 

and then accept. 

Mark the spot by clicking on take 

picture. 

Then select the camera or a 

picture already taken from the 

gallery. 
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While in recording mode, you can use the three dots at the top right of the menu option to 

view both the list of POIs recorded (“Waypoints”) so far and the recorded track (“Display track”). 

       

 

When you have finished your recording, you can save it at any time 

by clicking the ‘save’ icon at the top right.  

 

After saving the track and its POIs, you can long-click its list entry for 

different options. Among other, you can resume the recording, view 

the details, visualize the track, export or share it as a GPX file and 

even upload it to OpenStreetMap (a collaborative geodata project). 

To find or change the storage location of your exported GPX file, 

open the “settings” menu (via the three dots at the top right), and 

scroll to “GPX-Settings”. Under the subitem “External storage (SD) 

directory” you can see and change the internal or external storage 

location of your GPX directory.  

Feel free to try visualizing the track and exporting it as a GPX file.  

 

Note:  

Weak points: The OSMTracker application can only be used on Android devices, it does not 

work on iPhones. 

Strengths: Flexible, free, up to 2m accuracy, powerful satellite connection capability (fast 

connection, even in difficult environments as you don't need an internet connection). 
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VI- MODULE 6: DISCOVERING QGIS  
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6.1. Purpose of the module 

This module is dedicated to describing the QGIS software. It is a cartographic software package 

for processing and analysing data. It is used to view, process, and analyse the data collected 

with GPS in the field. This section will show you how to download and install QGIS. You will also 

learn about its interface and become familiar with it. 

6.2. History of QGIS 

QGIS is a free, multi-platform GIS (Geographic Information System) software released under 

General Public License (GPL). The project began in May 2002. It was also called Quantum GIS 

until September 2013. 

QGIS is a Free and Open Source Software. 

• OPEN-SOURCE SOFTWARE 

As the name suggests (open), the idea behind this concept is openness. Open-source software 

is open in the sense that anyone can access its source code and create derivative software 

products. The Open Source Initiative (an organization founded in 1998 by Bruce Perens and 

Eric Raymond) focuses on technical and not commercial considerations. It is compatible with 

software whose code is open but not free. In practice, however, a significant proportion of 

open-source software is indeed free to use. 

 

• FREE SOFTWARE 

The free software movement goes further and advocates philosophical values. Some would say 

it is almost political. 

Described for the first time in the 1980s by Richard Stallman, and popularised by his very strong 

campaigns (with very strong opinions) via the Free Software Foundation (FSF), the formal 

definition of free software is based on four freedoms: 

1. Freedom to run the program for any purpose. 

2. Freedom to study how the program works and adapt it to your needs. 

3. Freedom to redistribute copies. Underlying principle or philosophy: to help others. 

4. Freedom to improve the program and publish improvements. Underlying philosophy: 

to benefit the whole community. 

Two of these freedoms (the freedom to study how a program works and the freedom to 

improve it) imply de-facto access to the source code and therefore that the software is open-

source. 

NB: Open-source software is not necessarily free. 
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6.3. Downloading and installing QGIS 

❖ Download QGIS 

The procedure for obtaining QGIS is very simple. Just go to their official download site: 

https://www.qgis.org/en/site/forusers/download.html.  

From this site, you will find the latest versions of the software, the various updates and the 

stable versions of the software. The figure below shows the site interface. 

 

To download the software, simply click on "Download QGIS" and follow the procedure.  

It is advisable to use the latest stable version (Long Term Release – LTR) of the 

software, compatible with your environment (operating system, hardware 

architecture). QGIS LTR versions are more robust, with a better bug 

management. 

The QGIS site policy highlights the latest version. To download the stable LTR version, use the 

link right below the big green button:  

 

https://www.qgis.org/en/site/forusers/download.html
https://qgis.org/downloads/QGIS-OSGeo4W-3.28.11-1.msi
https://qgis.org/downloads/QGIS-OSGeo4W-3.28.11-1.msi
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❖ Version semantics 

 Major version Minor version Correction 

Numbering X. Y. Z 

Example 1 2. 18. 28 

Example 2 3. 22. 11 

Characteristics 

Non backward-compatible 
changes. Major evolutions 
bring new functionalities, 
radically changing the 
appearance or 
architecture of the 
software. 

Additions of 
backward-compatible 
functionalities, mainly 
bug fixes, and 
additions of some 
functionalities. 

Corrections of 
backward-
compatible 
anomalies, or 
security flaws 

At the time of writing, (stable) version 3.28 includes more than 4 patches. This continuous 

updating of the software is why we recommend working with stable versions, even if you won't 

be up to date with all the latest QGIS developments. 

❖ Installing QGIS 

After downloading, double-click on the downloaded file, which is probably located in your 

download folder. An installation window will appear giving you instructions to follow. As soon 

as the following window appears, click “Next”. 
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Then,  

1- Tick the box: “I accept the terms in the License Agreement” 

2- Click “Next” 

 

If you want to have shortcuts on your desktop and in the taskbar, tick both boxes as shown in 

the image below, then click ‘Next’. 

 

  

1 
2 
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Start the installation process by clicking ‘Install’ (you might have to enter your Windows user 

password); this process will take a few minutes. 

   

 

Once the installation is complete, click ‘Finish’. Check whether the software is now available 

on your computer and open it. 
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6.4. Discovering QGIS: Getting started 

❖ Understanding the QGIS interface 

Note: The official QGIS documentation is available here.  

Once QGIS is open, you'll see its interface, which we'll explore together.  

 

Menu bar (1) 

 
 

Toolbars (modifiable view) (2) 

 
 

Navigation panels (modifiable views and selections) (3) 

       

 

https://docs.qgis.org/3.28/en/docs/index.html
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Map view (4) Layer panel (5) 

  

Status bar (6) 

 

 

6.5. Main menu bar in QGIS 

The menu bar provides access to QGIS functions.  

Below is a description of the standard hierarchical menus. Note that extensions can add new 

options to the menus.  

 
The Project menu 

The “Project“ menu provides access and output points for the project file. It provides tools for: 

• Create a “New“ project file from scratch or use another project file as a template  

• “Open“ a project from a file, a GeoPackage or a PostgreSQL database 

• “Close“ a project or return it to its last saved state 

• “Save“ a project in .qgs or .qgz format, in a file, a GeoPackage or a PostgreSQL database 

• “Export“ the map canvas in different formats or use the layout sub-section for more 

complex outputs. 

• Set project “Properties“ and “Snapping Options“ for geometry editing. 

 
The Edit menu 

The Edit menu provides most of the native tools needed to edit layer attributes or geometry 

(see Editing for details). 

 “Edit“ menu items 

 Undo 

 Redo  

 Cut features 

 Copy features 

 Paste features 

https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#project
https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#edit
https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html
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Paste features as ► 

► New vector layer… 

► Temporary scratch layer… 

 Delete selected 

Select ► 

►  Select Feature(s) 

►  Select Features by Polygon 

►  Select Features by Freehand 

►  Select Features by Radius 

►  Select Features by Value… 

►  Select Features by Expression… 

►  Deselect Features from All Layers 

►  Deselect Features from the Current Active Layer 

► Reselect Features 

►  Select All Features 

►  Invert Feature Selection 

 Add a record 

 Add Point Feature 

 Add Line Feature 

 Add Polygon Feature 

 Add a curve 

 Add a circular string by radius 

Add a circle ► 

►  Circle from 2 points 

►  Circle from 3 points 

►  Circle from 3 tangents 

►  Circle from 2 tangents and a point 

►  Circle by a center point and another point 
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Add a rectangle ► 

►  Rectangle from extent 

►  Rectangle from center and a point 

►  Rectangle from 3 points (distance from the 2nd to 3rd point) 

►  Rectangle from 3 points (distance from the point projected onto segments p1 
and p2) 

Add a regular polygon ► 

►  Regular Polygon from center and a point 

►  Regular Polygon from center and a corner 

►  Regular Polygon from 2 points 

Add an ellipse ► 

►  Ellipse from center and 2 points 

►  Ellipse form center and a point 

►  Ellipse from Extent 

►  Ellipse from Foci 

Add annotation ► 

►  Text Annotation 

►  Form Annotation 

►  HTML Annotation 

►  SVG Annotation 

Edit Attributes ► 

►  Modifying Attributes of Selected Entities 

►  Merge Attributes of Selected Entities 

Edit Geometry ► 

►  Move Feature(s) 

►  Copy and Move Feature(s) 

►  Rotate Feature(s) 

►  Scale Feature(s) 

►  Simplify Feature(s) 

►  Add Ring 
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►  Add Part 

►  Fill Ring 

►  Delete Ring 

►  Delete Part 

►  Reshape Feature(s) 

►  Offset Curve 

►  Split Feature(s) 

►  Split Parts 

►  Merge Selected Features 

►  Vertex Tool (All Layers) 

►  Vertex Tool (Current Layer) 

►  Reverse line 

►  Trim/Extend Feature 

 Rotate Point Symbols 

 Offset Point Symbol 

 

Tools that can be used based on the type of geometry of the selected layer, i.e., point, polyline, 

or polygon: 

 

Menu bar Point Polyline Polygon 

Move Feature(s)    
Copy and Move 
Feature(s)    

 

 
The View menu 
The map is displayed in the map view (large main screen). You can interact with these views 
using the tools in the View menu. For example, you can: 

• Create new 2D or 3D map views in addition to the main map canvas; 

• Zoom in and out or move around the map; 

• Query the attributes or geometry of displayed entities; 

• Enhance the map display with preview modes, annotations, or decorations; 

• Activate/deactivate any panel or toolbar. 

The menu also allows you to reorganise the QGIS interface: 

• Toggle Full Screen Mode: covers the entire screen while hiding the title bar and the 

Windows task bar; 

https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#view
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• Toggle Panel Visibility: displays or hides activated panels - useful when digitising 

features (for maximum visibility of the canvas) and for presentations 

(projected/recorded) using the main QGIS canvas; 

• Toggle Map Only: hides the panels, toolbars, menus and status bar and displays only 

the map canvas. Combined with the full screen option, it allows your screen to display 

only the map. (It is advisable to remember the keyboard shortcut CTRL+Shift+Tab to go 

back to the default view.) 

 

 “View“ menu items 

 New Map View 

3D Map Views ► 

►  New 3D Map View 

►Manage 3D Map Views 

 Pan Map 

 Pan Map to Selection 

 Zoom In 

 Zoom Out 

 Identify Features 

Measure ► 

►  Measure Line 

►  Measure Area 

►  Measure Bearing 

►  Measure Angle 

 Statistical Summary 

 Elevation Profile 

 Zoom Full 

 Zoom to Selection 
 
 
 
 

https://docs.qgis.org/3.28/en/docs/user_manual/introduction/general_tools.html?highlight=zoom#panels
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 Zoom to Layer(s) 

 Zoom to Native Resolution (100%) 

 Zoom Last 

 Zoom Next 

Decorations ► 

►  Grid… 

►  Scale Bar … 

►  Image… 

►  North Arrow… 

►  Title Label… 

►  Copyright Label… 

►  Layout Extents… 

Preview Mode ► 

► Normal 

► Simulate Monochrome 

► Simulate Achromatopsia Color Blindness (Grayscale) 

► Simulate Protanopia Color Blindness (No Red) 

► Simulate Deuteranopia Color Blindness (No Green) 

► Simulate Tritanopia Color Blindness (No Blue) 

 Show Map Tips 

 New Spatial Bookmark… 

 Show Spatial Bookmarks 

 Show Spatial Bookmark Manager 

 Refresh 

Layer Visibility ► 

►  Show All Layers 

►  Hide All Layers 

►  Show Selected Layers 
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►  Hide Selected Layers 

►  Toggle Selected Layers 

► Toggle Selected Layers Independently 

►  Hide Deselected Layers 

Panels ►activate and deactivate any panel 

Toolbars ►activate and deactivate any toolbar 

Toggle Full Screen Mode 

Toggle Pane Visibility 

Toggle Map Only 

 

Note: Under Linux KDE, the Panels ►, Toolbars ► and Switch to full screen mode menus are 

in the Preferences menu. 
 

The Layer menu 

The Layer menu provides a wide range of tools for creating new data sources, adding them to 

the project or saving changes to them. Using the same data sources, you can also: 

• Duplicate a layer to generate a copy where you can modify the name, style (symbology, 

labels, etc.), joins, etc. The copy uses the same data source as the original; 

• Copy and Paste layers or groups from one project to another as a new instance whose 

properties can be modified independently. As with Duplicate, layers are always based 

on the same data source; 

• Embed layers and groups from another project, e.g., from a read-only copy that you 

can't modify. 

The Layer menu also contains tools for configuring, copying, and pasting layer properties (style, 

scale, Coordinate Reference System, etc...). 

 “Layer“ menu items 

 Data Source Manager 

Create Layer ► 

►  New GeoPackage Layer… 

►  New Shapefile Layer… 

►  New SpatiaLite Layer… 

►  New temporary Scratch Layer… 

https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#panels
https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#toolbars
https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#layer
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►  New Mesh Layer… 

►  New GPX Layer… 

►  New Virtual Layer… 

Add Layer ► 

►  Add Vector Layer… 

►  Add Raster Layer… 

►  Add Mesh Layer… 

►  Add Delimeted Text Layer… 

►  Add PostGIS Layer… 

►  Add SpatialLite Layer… 

►  Add MS SQL Server Layer… 

►  Add Oracle Spatial Layer… 

►  Add SAP HANA Spatial Layer… 

►  Add/Edit Virtual Layer… 

►  Add WMS/WMTS Layer… 

►  Add XYZ Layer… 

►  Add ArcGIS REST Service Layer… 

►  Add WCS Layer… 

►  Add WFS Layer… 

►  Add Vector Tile Layer… 

►  Add Point Cloud Layer… 

►  Add GPX Layer… 

Embed Layers and Groups 

Add from Layer Definition File… 

 Georeferencer 

 Copy Style 

 Paste Style 

 Copy Layer 

 Paster Layer/Group 
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 Open Attribute Table 

Filter Attribute Table ► 

►  Open Attribute Table (Selected Features) 

►  Open Attribute Table (Visible Features) 

►  Open Attribute Table (Edited and New Features) 

 Toggle Editing 

 Save Layer Edits 

 Current Edits ► 

► Save for Selected Layer(s) 

► Rollback for Selected Layer(s) 

► Cancel for Selected Layer(s) 

► Save for all Layers 

► Rollback for all Layers 

► Cancel for all Layers 

Save as… 

Save As Layer Definition File… 

 Remove Layer/Group 

 Duplicate Layer(s) 

Set Scale Visibility of Layer(s) 

Set CRS of Layer(s) 

Set Project CRS from Layer 

Layer Properties… 

Filter… 

 Labelling 

 Show in Overview 

 Show All in Overview 
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 Hide All in Overview 

 

The Settings menu 

“Settings“ menu items 

User Profiles ► 

► default 

► Open Active Profile Folder 

► New Profile… 

 Style Manager… 

 Custom Projections… 

 Keyboard Shortcuts… 

 Interface Customization… 

 Options… 

 

  

https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#settings
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The Plugins menu 

QGIS is based on a system of extensions. This makes it easy to add new features to the software. 

Some QGIS functions are implemented as extensions. QGIS extensions are either main 

extensions or external extensions. 

Main extensions are maintained by the QGIS development team and are automatically part of 

every QGIS distribution.  

To install an extension, go to the menu          and select  

NB: The main extensions may not all be loaded when you start QGIS for the first time, which is 

why you need to know how to download and install extensions in QGIS. 

 

The Vector menu 

The vector menu is used to process and analyse all vector layers that can be modified in any 

way.  

By default, QGIS adds Processing algorithms to the      menu, grouped by sub-menus. 

This provides shortcuts for many common vector-based GIS tasks from different providers. If 

not all these sub-menus are available, enable the “Processing” plugin in  

 

 

The Raster menu 

The raster menu is used to process and analyse all pixel layers (image, photo, etc.). 

 

https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#plugins
https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#vector
https://docs.qgis.org/3.28/en/docs/user_manual/introduction/qgis_gui.html#raster
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VII- MODULE 7: HANDLING GPS DATA 

WITH QGIS 
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7.1. Purpose of the module 

This module shows you how to process data once you have collected them in the field. 

This stage of the course is all about making the data "speak". Therefore, you will learn how to 

import GPX data into QGIS, create shapefiles, and transform point data to lines or polygons.  

 

7.2. Processing GPS data in QGIS 

In this section, you will learn how to transfer data to the computer for its use in the QGIS 

software. 

7.2.1.  Connecting the GPS receiver to the computer to retrieve GPX data 

The most common procedure is to incorporate the data from a file in .gpx-format produced by 

the GPS receiver or OSMTracker. 

 

GPX data generated by a “Garmin” receiver 

1: Connect the GPS receiver to the computer via cable; 

2: When the computer prompts that the device is connected, open the File Explorer/Finder, 

navigate to the device and open the folder "Garmin"; 

3: Then open the folder "GPX"; 

4: Copy the GPX file containing the date of collection in its name onto the computer's hard drive 

(in our case, three files are copied); 

5: Paste the copied file into a folder previously created on the computer (in our case, we named 

the folder “DATA_GPS_COLLECTER“. 

 

Figure: Steps for transferring GPX data from the GPS device to the computer 
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GPX data generated by OSMTracker 

1. Export the GPX file from OSMTracker to your phone storage (named by the date);  

2. Connect your phone with the computer and navigate to the storage directory; 

3. Copy the GPX file and paste it into a folder previously generated on the computer, 

e.g. “DATA_GPS_COLLECTER“. 

 

 

7.2.2. Importing GPX data into QGIS 

Launching QGIS after installation 

There are three very simple ways to open the QGIS software.  

The first is to type the word "QGIS Desktop" in the search bar, and the software logo is 

immediately displayed. All the user has to do is click on the logo. 

The second option is to double-click the software logo on the desktop.  

The third option is to open the "Start" menu, then search for the QGIS software. Once you've 

found it, click on the logo. 

 

Importing data into QGIS 

Several methods can be used to import the data extracted from the GPS receiver, which are 

now located in the folder “DATA_GPS_COLLECTER”, into the QGIS software.  

1. The simplest method is the “Select and Drag and Drop” technique. In this technique, 

hold down the "Ctrl" button on the computer keyboard, click on all the files you would 

like to import into QGIS (one click each file only), then drag the data and drop them 

into the software's map view area.  

2. The import technique from the QGIS Browser panel, depending on the type of data 

(Vector or Raster or others such as GPX): This technique involves first of all searching 

for and identifying the data to be imported using the QGIS "Browser" panel, which 

allows you to browse directories and explore data. Navigating to your GPX files you will 

find the following subitems: “route_points” (POINTS), “routes” (LINES), “track_points” 

(POINTS), “tracks” (LINES), “waypoints” (POINTS). In our example we only copied 

“waypoints.gpx” from the GPS receiver, correspondingly only “waypoints” will contain 

data. In case you are working with GPX files from OSMTracker, you have also exported 
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the track that you have walked with your mobile phone. Therefore, the subitems 

“waypoints”, “tracks”, and “track_points” will contain data. 

 

3.  Importing GPX data from the “Layer Manager” toolbar 

 

(If you don't see these buttons, activate them in the ribbon under "View" --> "Toolbars" --> 

"Manage Layers Toolbar".) 

 

• Click on the “Add a vector layer” icon (1); 

• Click on the browse icon marked with three dots […] (2); 

• Select the data you want to import (3), then click “Open” (4); 

• Click “Add” (5). 

 

Importing vector data from the “Manage Layers Toolbar” next to the 
“browser” panel 

Importing raster data from the “Manage Layers Toolbar” next to the 
“browser” panel 
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Once you've clicked “Add”, a dialogue box will open showing you the existing data within the 

GPX file. You can either select all layers or select specific data and click on “Add Layers”. 

 

 

Example of the successful import of waypoints: 

 

 

NB: The same processes apply to importing Raster data. 

 

For a more detailed manual please refer to the QGIS documentation on working with GPS data. 

  

https://docs.qgis.org/3.28/en/docs/user_manual/working_with_gps/index.html#working-with-gps-data
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7.3 Creating a data base / export to shapefile 

By definition, a database is a collection of information organized in such a way that it can be 

easily accessed, managed and updated. It is used by organizations as a method of storing, 

managing and retrieving information. 

In this case, the database is a folder dedicated to structuring the generated data. In our case, 

the data will be located in the “DATA_GPX_COLLECTER” folder, which already contains our GPX 

files. This folder, containing all the data created (points, lines, polygons), represents the 

geographic database. 

 

• Convert and export GPX data to shapefile 

There are several steps to exporting data. Right-click the layers/data concerned, then click 

"Export", then "Save Features As…".  
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The dialogue box “Save Vector Layer as..” opens. Select 

ESRI Shapefile as the output format. 

Open the browser dialogue by clicking on the button 

with three dots to the right of ‘File name’. Navigate to 

your desired location (insert a new folder called “SHP” – 

short for shapefile), type in a name for the new shapefile 

layer and click “Save”. 

Click on “OK” to convert the GPX file into a shapefile. 

 

 

 

 

 

If the conversion was successful a notification pops up at the top of the map view. 
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If you now browse to the file 

path, there will be several files 

in your “SHP” folder. All files 

together compose your 

exported shapefile. The single 

files are linked to each other 

and contain different 

information, such as the CRS 

within .prj, the attribute table 

in .dbf and the geometrical 

shape in .shp. Use the file 

ending on “.shp” if you want to 

import files (select or drag and 

drop) into QGIS again. 

 

7.4 Understanding the data attribute table 

The “attribute data“ in a geographic data file, or “attribute table“, is easily accessible in QGIS. 

Each column in the attribute table, also known as a “field“, contains information (or a 

"variable") describing the spatial features (e.g., name, classification, area, etc...). 

This data can be used for various operations, such as:  

• Data selection: for example, to select countries whose demography is higher than a 

given value. 

• Using a symbology: for example, to assign a colour to the data according to its 

importance. 

In the attributes table, a row (or a “record“) corresponds to a spatial entity (or a “feature“). 

One spatial feature can be a single geometry (one point, one line, one polygon) or be made up 

of several spatially distinct polygons, lines or points. In the second case it is referred to as a 

“multipart feature“. 

7.5 Adding coordinate information into the attribute table of GPS points 

Why generate the coordinates automatically when we sometimes have a notepad or an 

information sheet in which we noted the coordinates by hand during a field campaign? 

Because data are very sensitive element and should not be manipulated unless absolutely 

necessary. Once they are wrongly noted, the information extracted from the raw data will 

become distorted. Each coordinate is unique and just like DNA, there are no 2 similar 

coordinates. 

That being said, if we have to manipulate or correct a coordinate, we can do so in the attribute 

table. To do this, we first go into the attribute table to check whether our points have X, Y or Z 

coordinates listed in the table. To open the attribute table, right-click the GPS point data layer 

within the “Layers” panel and click “Open Attribute Table”.  
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Browsing through the attribute table of our GPS data we cannot see any coordinate information. 

Therefore, we will automatically generate and add coordinates to the attribute table. 

To do that, mark the shapefile layer within the “Layers” panel. Open the “Vector” menu at the 

top and navigate to “Geometry Tools” , then click “Add Geometry Attributes”. 
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The dialogue box opens to run the function. Select the shapefile layer as input and click 

“Run”. 

 

  

After the function has been executed, the Log frame gives an in-depth overview of the 

processing and the result status. If it says “Algorithm … finished”, you can “Close” the box.  

 

 

 



 

62 

A temporary ‘scratch layer’ called ''Added_geom_info'' appears. To open its attribute table, 

right-click on this layer and select “Open Attribute Table”  

 

 

The attribute table now contains coordinate information for every point (row). 
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7.6 Transformation of points to lines 

Select the shapefile layer > open the “Processing toolbox” panel by pressing CTRL+ALT+T > 

Unfold the “Vector creation” category > select the function “Points to path”  

 

 

Select your shapefile as “Input layer” > tick the box ''Create closed paths'' > select a column 

from the attribute table that indicates in which order the points will be connected. In case these 

numbers are part of a text string (e.g. “WP1”) tick “Sort text containing numbers naturally” > 

then “Run” > and “Close” after successful execution 
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A newly generated layer called “Paths” now shows a line (the only feature of the layer) 

connecting the points. This still is a temporary scratch layer. In case you want to save this layer 

into a file, right-click on the layer > select “Make Permanent”. Select ‘Shapefile’ as output 

format and set your preferred storage location.  

 

ATTENTION! Have you captured several distinct polygons in the field and stored their waypoints 

all together in one common file? Then we must group the points to clearly indicate which points 

belong to which polygon. Only then one line for each polygon is drawn. Otherwise, this function 

will simply connect all points to one single line. 

To group the points, we need a 

column/variable in the attribute table that 

indicates each point’s affiliation to the 

corresponding polygon. In this example 

below this is the column “Code” that 

indicates whether a point belongs to polygon 

1 (P1), polygon 2 (P2), etc…. 
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In the dialogue box of the function “Points to 

Path” you can now select the column 

indicating the affiliation at “Path group 

expression [optional]” besides the other 

settings (input layer, closed path, order 

expression). Now when you click ‘Run’ 

several lines will be created, one for each 

polygon. 

 

 

 

 

7.7 Transformation of lines to polygons 

In the previous step we have created one or several closed paths (in closed paths, the starting 

point is the same as the ending point). These are still stored as lines and not as polygons. Closed 

paths do not have an interior or exterior like a polygon and therefore no intersection checks 

could be performed, e.g., what field boundaries intersect with land classified as forest.  

To transform a closed path line into a polygon, follow these steps: Select the path layer in the 

“Layers” menu (1) > go to the “Processing Toolbox” (2) unfold the “Vector geometry” section 

(3), and open the function “Lines to polygons” (4). 
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In the function’s dialogue box, 

make sure the correct layer 

(the previously created closed 

path line) is inserted as the 

“Input layer”. Then click “Run” 

to execute the polygon 

creation. 

 

 

 

 

 

 

 

 

You have now successfully created one or several polygons, which you can already recognize 

by the filled symbology in your map view.  

Be sure to make it a permanent file: Right-click on the layer > select “Make Permanent”. Select 

‘Shapefile’ as output format and set your preferred storage location.  
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7.8 Merging single vector layers into one common layer 

ATTENTION! In case you captured waypoints for each polygon in a separate GPX file, you will 

have to create single layers and ultimately a single file for each line or polygon transformed 

from the GPX data.  
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To aggregate single layers into a common layer, go to the “Processing Toolbox” (CTRL+ALT+T) 

> “Vector general” > and open the function “Merge vector layers”. Select the input layers you 

want to merge (1). You may want to set the CRS (2) which will be EPSG 4326 in most cases, 

however, this information is usually taken automatically from the input layers. On the right you 

find further information about the detailed processing. Click “Run” to execute the function and 

aggregate multiple layers/files into one layer/file. Note that you cannot merge layers of 

different geometry (such as points with lines or polygons) 
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7.9 Calculate the area of polygons 

Before calculating the surface area of a polygon, you need to make sure that the unit of 

measurement is set correctly. As our GPS data have their coordinates stored in the CRS WGS84 

(EPSG:4326), and therefore in degrees, we must ensure that the area is calculated based on 

metric geometries.  

To do this: 

1. Click on ''Project'' in the menu bar 

2. Open the “Properties” 

3. Then, on the left open the tab “General”  

4. Under the subsection “Measurements” you can choose your preferrable unit at 

“Units for area measurement” as well as for “Units for distance measurement” 

5. “Apply” your changes and click “OK” 

 

 

As the area/size of each polygon within one layer is a descriptive information, it belongs into 

the attribute table. We can add new variables as columns in the attribute table. To do that, first 

open the attribute table. Mark the layer within the “Layers” panel, and then either right-click 

on the layer and “Open Attribute Table” or click on the icon of the “Attribute Table” within the 

toolbar at the top. 

The attribute table opens and as we will subsequently edit 

the data, we have to activate the editing mode by clicking 

the yellow pen icon at the top left of the attribute table.  

Now select the icon for adding a field which you also find at the top. 
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A dialogue box pops up for adding a new field. Fill in the following information:  

1. Insert a suitable “Name” such as “AREA”; 

2. In the “Comment” field insert the measurement unit (e.g., in our case “hectare”); 

3. Select a suitable field data “Type”. As we will store the area in numbers, we have to 

choose a quantitative data type, and as we also want to store decimals we choose 

“Decimal Number (real)". 

4. Insert the maximum field “Length” (e.g., by default 10)  

5. Set the “Precision” which refers to the number of digits after the comma (e.g., 2) 

6. Click “OK” to add the field to the attribute table. 

 

You can now see the added column “AREA” on the right of your attribute table. Hovering over 

the header of the column we also see its settings and the comment. Commented columns are 
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very useful for later users, especially the measurement unit for numerical information such as 

the area. However, so far there is no data stored within this column. 

To feed the column with the automatically generated area we will use the “Field Calculator”. 

You can directly open the “Field Calculator” from the attribute table by clicking on its icon 

at the top. 

 

Alternatively, you can open the “Field Calculator” via a click on its icon within the 

“Attributes Toolbar” at the top.  

 

The “Field Calculator” is used to modify existing fields or to create new fields based on 

expressions. To finally calculate the area, follow these steps within the dialogue box:  

1. Tick “Update existing field”; 

2. Select your freshly created new field “AREA”; 

3. Now we can select the expression which will calculate the information for every polygon 

feature of the layer. There are a lot of useful functions for all kinds of calculations (for 

more information see QGIS documentation: Using the Field Calculator). For our purpose 

we unfold the “Geometry” options. 

4. Here we double click on “$area”, to calculate the area based on the measurement 

settings we have previously adapted. Attention: Don’t mix it up with “area”, as this 

won’t respect the settings.  

5. Through a double click the function is pasted into the “Expression” field. You can already 

see a preview of the results below the expression field.  

https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/attribute_table.html#using-the-field-calculator
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6. Click “OK” to execute the area calculation. 

https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/attribute_table.h

tml 

With the execution of the function, the editing mode is directly activated. You can 

notice that by the editing symbol in front of your polygon layer within the “Layers” panel and 

by the highlighted editing mode in the “Digitizing Toolbar” on top. Before saving the 

changes, we first check the results of the area calculation.  

We can now see the 

new column called “AREA” within 

the attribute table, where for each 

polygon the area is shown in the 

selected measurement unit (here: 

hectares). 

If everything appears correct, we 

can save the newly entered data 

by clicking on the toggle 

icon to deactivate the editing 

mode and confirm the saving.  

  

https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/attribute_table.html#using-the-field-calculator
https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/attribute_table.html#using-the-field-calculator
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VIII- MODULE 8: DIGITIZING GEODATA 

WITH QGIS 
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8.1 Purpose of the module 

This module will show you how to insert basemaps into QGIS and use them for manually 

digitizing polygons, inserting attributes and saving them as shapefiles.  

8.2 Adding background maps 

From the menu bar at the top unfold the “Layer” options > go to “Add Layer” and select “Add 

XYZ Layer”. Click on “New” to add a new connection (1). 

• Add the name of the connection: OpenStreetMap (2) 

• Add the URL (copy and paste to avoid errors!) (3) 

https://tile.openstreetmap.org/{z}/{x}/{y}.png  

• Click “OK”: A new connection is now available! 

 

 

You can now select our established connection and click “Add” to add it to the map view.  

 

Alternatively, you can use the “Browser” panel. Browse to “XYZ Tiles” > either double click on 

existing basemaps for adding them, or right-click on “XYZ Tiles” to add a new connection as 

described. 
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Besides thematic background maps (such as OpenStreetMap) there are also imagery basemaps 

(such as Google Satellite). Here is a link to a script that you can copy paste into the “Python” 

console within QGIS to add several basemaps at once. Open the “Python” console from the the 

toolbar at the top  (1). Paste the copied script into the console (2) and press Enter to execute 

it. Now you should have more basemaps listed under “XYZ Tiles” in your browser panel 

(including imagery basemaps). Note that it is your responsibility to comply with each basemap’s 

terms of use. 

  

https://github.com/klakar/QGIS_resources/blob/master/collections/Geosupportsystem/python/qgis_basemaps.py
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If you are registered for Planet NICFI data, there is also the “Planet Explorer” plugin for QGIS 

(https://developers.planet.com/docs/integrations/qgis/) that you can install and use to view 

monthly updated basemaps created from Planet satellite imagery over tropical areas.  

  

https://www.planet.com/nicfi/
https://developers.planet.com/docs/integrations/qgis/
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8.3 Digitizing polygons as shapefiles 

You can also create polygons by digitizing them on the basis of high-resolution imagery. Be sure 

to know the exact source of your imagery, especially the acquisition time and accuracy, to 

create high-quality field boundary data.  

1. Creation of an empty shapefile 

Create an empty shapefile either via the “Browser” panel on the left (1A) or via the “Layer” 

menu at the top > “Create Layer” > “New Shapefile Layer…” (1B).  

Within the appearing dialogue box, give the file a name (2) and select a storage location by 

clicking the three dots next to the field. A geometry type (3), choose “Polygon”. Under “New 

Field” (4) you can already pre-define columns for the attribute table, e.g., company internal IDs, 

names farmers, crop types, etc…. Click “OK” to create the empty shapefile.  

 

2. Digitizing polygons into the shapefile 

As you have now created an empty shapefile for 

polygons, you can fill this file by digitizing 

polygons based on the background imagery. To 

activate the editing mode, select the layer 

within the “Layer” menu (1) and click on the 

yellow pen at the toolbar on top (2).  

When the editing mode is activated, some 

functionalities from the toolbar menu above are 

ready to be utilized now. Make sure you have 

activated at least the “Digitizing Toolbar” under 

the “View” > “Toolbars” menu. Besides more 
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advanced digitizing tools, the basic functionality to add simple polygons to your file is now ready 

to use. 

 

Click on the icon  . (Depending on your QGIS version, you might have to make sure that you 

are in the mode “Digitize with Segment”, that you can select from a dropdown menu next to the 

icon.) Start drawing with left clicks while each click creates a point/vertex that are combined to 

a closed polygon. If you want to delete a vertex, use the “delete” or “backspace” key on your 

keyboard. You can finish your geometry by right-clicking (QGIS Documentation 16.3.4.2 Editing 

- Adding Features). Afterwards, the dialogue box appears to insert the thematic data 

(attributes) that are linked to this field. Finally click on “OK” to save the feature to the layer. 

 

You can now see the newly created polygon on the map and as a feature within the attribute 

table. You can repeat these steps to add more polygons to this layer. 

  

https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html#adding-features
https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html#adding-features
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IX- MODULE 9: MAP VISUALIZATION & 

PRODUCTION IN QGIS  
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9.1 Modifying the symbology of a layer 

Data symbology is a key element in representing data in an intuitively understandable way on 

a map through colours, colour gradients or palettes, symbols, etc. The use of labels often 

provides additional useful information (name or type of objects, values linked to objects, etc.). 

To access all the symbology functions of a layer, 

• Right-click on the layer name in the layer panel (1) 

• Choose "Properties” (2). Within the new window switch to the tab “Symbology" (3). 

• Choose the type of symbology best suited for your data (4) 

Single Symbol 

All objects are represented in the same way. Choose "Single Symbol” from the list at the top of 

the window, then set the colour (including line thickness, outline colour, fill type, etc.). 
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Categorized / Graduated 

The objects are displayed differently 

depending on the values in the 

associated attribute table. Choose 

“Categorized” or “Graduated” (1) from 

the list. Categorized symbology is useful 

for discrete values (e.g., land use or 

crop types) and graduated symbology is 

best for continuous values (e.g., 

production amounts or vegetation 

density). Under “Value” (2), select the 

column containing the field values that 

will determine the visualization, then 

click the "Classify" (3) button. There are 

different possible classifications and 

you can create your own categories. All the values in a field can be differentiated. This mode 

can be used for both text and numeric values. To see the result, click “Apply” (4). You can 

experiment and find a symbology that you find suitable. When you are happy with the result, 

click “OK” (5).  

 

ATTENTION! For the "Categorized" and "Graduated" symbology types, the symbology is based 

on the information contained in the attributes table. You must therefore: 

• Define the column (in the "Value" menu) in the attributes table on which the symbology 

is based. It will sometimes be necessary to create the attributes in the attributes table 

on which the symbology will be based (16.2. Working with the Attribute Table — QGIS 

Documentation documentation). 

• Don't forget to click the "Classify" button to create the desired symbology. 

  

https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/attribute_table.html?highlight=attribute%20table
https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/attribute_table.html?highlight=attribute%20table
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9.2 Adding labels 

From the Layers panel, right-click the desired layer > select "Properties" and switch to the tab 

"Labels" (1). Select "Single Labels" (2), then for "Value" (3) indicate the field containing the 

values to be displayed. Set the font style to your preferences (4) and click “Apply” (5). 

 

 

9.3 Map layout interface 

Cartographic editing in QGIS is done in a "Print Layout” interface, which is a window 

independent of the main QGIS interface. 

The layout interface is used to create and save/publish a single map layout. If several variants 

of the same map need to be created, then several layouts need to be created. 

How to create a layout: 

• Open “Project“ from the menu bar > Click “New Print Layout …» 

• Insert a title in the dialogue box popping up (or select “Page layout 1” by default) 
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A blank page layout interface appears. 

 

 

The size of the map (A4, A3, etc) and the "Portrait" or "Landscape" layout mode can be 

predefined: 

• Right-click on the map > select “Page Properties“ > navigate to the tab “Item Properties” 

> choose the size and orientation of your choice. 
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You can add several map items as listed below. Feel free to experiment and find the right 

layout. When you are done with the layout, you can export the map in different formats (PDF, 

regular image, SVG vector graphics. 

“Map“ items 

 Add Map 

 Add Picture 

 Add text (e.g., title, copyright) 

 Add Legend 

 Add Scale Bar 

 Add Shape 

 Add Arrow 

 Add Attribute Table 

 Add HTML Frame 

    Tools to Zoom 

  Tools for locking 

  Tools for grouping/ungrouping 

Tools for aligning/repartitioning map elements 

   Export your map in different formats 
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9.4 Elements to appear on a map 

Here's a list of the main elements to be included in a map, regardless of the theme.: 

• Map title; 

• A bar scale indicating the ratio of distances on the map to the real-world surface (digital 

scale if required); 

• A legend; 

• A north arrow; 

• Author (person and/or “Company“); 

• Information on the Coordinate Referencing System (CRS) used (name of coordinate 

system and datum); 

• Map creation date; 

• Sources and dates of data used to create the map; 

Other useful elements to add  

• Neighboring map references (if your map is part of a set of adjoining maps) 

• A geo-referencing grid or graticule; 

• A bounding rectangle 

 

Note: A map should not be overloaded; the colours used must allow the map to be readable 

and understandable (use the “Preview” mode under the menu item “View”); fonts must be 

visible and legible.  
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X- MODULE 10: SUSTAINABLE 

MANAGEMENT OF NATURAL 

RESOURCES  
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10.3 Purpose of the module 

This module addresses sustainability, monitoring and traceability. By analysing your data, you 

may find plots that are in illegal areas such as classified forests, reserves, etc. (Advice: Check if 

governmental open data platforms are available with data on land use or forest geodata (e.g. 

WHISP).  

By doing these analyses, you can detect problematic plots and other potential difficulties early 

in order to anticipate them. 

10.4 How to detect plots in illegal areas? 

After the collection of waypoints in the field and its transformation to polygons, this work is 

carried out downstream to check the quality of the work carried out by the agents in the field 

and to assess the location of fields compared to other geospatial data, such as forest data. 

❖  Display points, lines or polygons of parcels in QGIS (in this case points): 

 

❖ Add a layer with classified forest area, and drag it to the bottom in the “Layers” panel. 

You can use a filter (right-click > “Filter”) on the available attributes (e.g., forest type) to 

only display distinct features of the layer. 

 

https://whisp.earthmap.org/?aoi=WHISP&boundary=plot1&layers=%7B%22CocoaETH%22%3A%7B%22opacity%22%3A1%7D%2C%22JRCForestMask%22%3A%7B%22opacity%22%3A1%7D%2C%22OilPalmFDAP%22%3A%7B%22opacity%22%3A1%7D%7D&map=%7B%22center%22%3A%7B%22lat%22%3A7%2C%22lng%22%3A4%7D%2C%22zoom%22%3A3%2C%22mapType%22%3A%22satellite%22%7D&statisticsOpen=true
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❖ Identify points, lines or polygons that are located INSIDE of the classified forests.  

Click “Selection by Location”  within the “Selection Toolbar”. 

 

The dialogue box for selecting features by location pops up. 

Generally, you can always click on the “Help” button (0) of each function, that redirects you to 

the QGIS documentation. In this case you get more details about the process here.  

 

https://docs.qgis.org/3.28/en/docs/user_manual/processing_algs/qgis/vectorselection.html#select-by-location
https://docs.qgis.org/3.28/en/docs/user_manual/processing_algs/qgis/vectorselection.html#select-by-location
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1. Under “Select features from”, choose the layer from which you want to select (identify) 

the features. In our case this would be the GPS data layer that we created in previous 

chapters. 

2. Choose the “Where the features (geometry predicate)”. These are rules for comparing 

the input features’ geometric location to the geometries from the “base-comparison” 

layer. Use the “Help” button to see examples of each geometrical predicate. In our case 

we choose “intersect” which means that all GPS points are selected that in any way 

intersect with the forest polygon (i.e., touch, or are within the forest polygon).  

3. Choose the “By comparing to the features from” layer, which means that the selected 

rule (geometric predicate) compares features from the input layer to this layer. In our 

case this would be a forest polygon from another source. 

4. Click “Run” to find out which GPS points intersect with the forest polygon. 

 

❖ The selected GPS points, lines or polygons are now highlighted yellow on your map.  

This indicates that these points/features are actively selected within the point layer. In case 

you want to export only these points, lines, or polygons you can right-click on the layer > select 

“Export” > “Save Features As”. Within the window that pops up, make sure to tick “Save only 

selected features” and select a storage location. 
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❖ Identifying waypoints that are located OUTSIDE of the classified forests.  

Follow the previous steps but instead of choosing “intersect” as geometric predicate choose 

“disjoint”. 

 

 
 

 

 

 

 

 

 
10.5 Measuring distances between two objects in QGIS 

 
The aim here is to measure the distance between two objects. If we have plots of land that are 

at a certain distance from classified forests, we can measure them ourselves in order to avoid 

trade refusals caused by new regulations. 

Click on the “Measure Line” tool  at the top within the “Attributes Toolbar”. Make sure to 

measure a line, by clicking on the dropdown and selecting “Measure Line”. 

 
 

Using the measuring tool, left-click on the 

starting location and then left-click again on the 

ending location on the map. Within the dialogue 

box you can already see the measured length 

varying dynamically. To freeze the measurement, 

right-click. 
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XI- MODULE 11: FROM THE OFFICE TO 

THE FIELD (FROM QGIS TO GPS)  
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11.1. Purpose of the module 

Just as you go out into the field to collect data and then come back to the office to process 

them, you can also prepare data at the office for further surveys, verification and analysis of 

objects or phenomena in the field, and even create visibility and reference points for the 

collection of other data in the field. 

11.2. Creating centers of polygons 

To locate polygons in the field with a GPS device, it is often easier to transform them back to 

points by calculating their geometrical centre. In this sub-section, we'll show you how to create 

them automatically with the QGIS software. 

1. Mark the polygon layer in the “Layers” panel; 

2. Select the “Vector” menu in the menu bar; 

3. Unfold the “Geometry Tools”; 

4. Select “Centroids”. 

 
 

Within the dialogue box of the 

“Centroids” function select your 

polygon data layer as “Input Layer” (1). 

Tick the option “Create centroid for 

each part” (2). Finally execute the 

calculation via a click on “Run” (3).  
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You can now see that every polygon is represented by a central point.  

 

 

11.3. Export point data to GPX file 

In order for your GPS device to read these or any other point data, you will have to transform 

the point layer to GPX format via the export function. Select the layer in the “Layers” panel and 

right-click on it (1). Select “Export” (2) and “Save Features As” (3).  
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In the opening dialogue box, select the 

"GPSeXchange Format [GPX]" (1) format, 

choose a file location and click "OK". 

 

 

 

 

 

 

 

11.4. Importing the GPX layer into the GPS receiver or smartphone 

If you are working with a GPS device, follow these steps: 

• Connect the GPS device to the computer; 

• Navigate to your local folder containing the GPX files, copy them and paste them it into 

the GPX folder of your GPS device. 

 

Alternatively, if you are working with a GPS enabled smart phone, there are several free Apps 

that can visualize GPX data, such as Organic Maps or MAPS.ME. In that case, follow these steps:  

• Transfer the GPX files to your smartphone (either via plugging it to your desktop 

computer or any other transfer option) and save them at your preferred location on the 

phone. 

Open the GPX files with whatever app you are using.

https://organicmaps.app/
https://maps.me/
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XII- MODULE 12: FINAL EXERCISE 
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12.1. Exercise 1 

 

1. As part of this exercise, you will first create a QGIS project called "Exercise". 

2. From the "Exercise_Data" folder, import into QGIS the two GPX files named 

"Waypoints_11-NOV-21.gpx" and "Waypoints_15-NOV-21.gpx" respectively. 

3. Convert these two files into SHP format and then export them to a folder called " SHP" 

inside the "Exercise_data" folder. The files should be named "Points_15-NOV-21_shp" 

and "Points_11-NOV-21_shp" respectively. 

4. Merge the two files into a single file called "Points_NOV-21-merged_shp". 

 

 

12.2. Exercise 2 

 

1. Edit the "Points_NOV-21-merged_shp", then add 5 new points that you will create 

manually and directly from your QGIS software. When editing, name them 

consecutively (New point 1, New point 2, New point 3, etc.). 

2. Depending on the arrangement of the points, create a new polygonal shape file named 

“Polygon_NOV-21_shp” with a column “NAME” and then digitise two polygons around 

these points. Each polygon created should be named Polygon 1 and Polygon 2. Below 

is an example: 
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12.3. Exercise 3 

1. For this exercise, the layer used is "Waypoints_12-NOV-21.gpx". Import the file into 

QGIS, transform it into an SHP layer, go to the attribute table, add a "Place" field column 

and name the two points "Place 1" and "Place 2" respectively. 

2. Then call up the "OpenStreetMap" background map and digitise two more points. 

These points must be at the places of Yakassé Attobrou and Biéby marked on the 

OpenStreetMap base map. In the column for the "Place" field, name each point after 

the town marked on the OpenStreetMap base map. 

3. Now, create the suggested symbology and labelling (see figure below). 

4. At the end of this exercise, you will create the layout (with all the elements that should 

be included on a map) and export the map as a PNG image and then as a PDF.  
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12.4. Exercise 4: Set a CRS 

 

In the "CRS_Error" folder, load the "18-NOV-21_parcelles" layer into your QGIS project. 

Normally this data should be located within the country of Honduras but is seems to be 

mislocated. The wrong CRS has been linked to it. But since you know that the data was originally 

collected via GPS, correct the CRS to EPSG:4326 - WGS84. Save the file as “18-NOV-

21_parcelles_WGS84”. 

 

 

12.5. Exercise 5: In search of a point 

 

This exercise asks you to find an object located at a precise point in your area. Take any of your 

files or create a file that contains polygon field data from your region: 

1. Create centroids of your polygons. 

2. Save the point data as a GPX file to a corresponding ”GPX” folder.  

3. Transfer this data into a GPS/smartphone and go to one of the marked locations using 

your GPS device. 

 

 

12.6. Exercise 6: Spatial analysis and sustainable resource management 

 

You are the technical supervisor of a local cooperative, and you have digitized your fields in the 

recent past. Within the "parcels.shp" shapefile contained in the "Spatial_Analysis" folder you 

have some exemplary data of this. You additionally have a “forests.shp” layer within the same 

folder. It is now your task to check whether your field polygons are located within forests or 

not: 

1. How would you approach this task? 

2. Save the parcels that intersect with forests as a file “parcels_in_forests.shp” 

within the “Spatial_Analysis” folder. 
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